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Quintette™

The Dancing Stones

quintet, quintette (kwin tet”) n. [< Fr. or It.: Fr. quintette <«

It. quintetto, dim. of quinto, a fifth < L. quintus: see QUINT!]
1. Music a) acomposition for five voices or five instruments,
as for string quartet and piano b ) the five performers of such a
composition 2. a group or set of five persons or things
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Quintette™, a re-creation of the classic Japanese game
Ninuki-Renju, is a fast-paced strategy game for two
players, based on several ancient games such as GO and
Go Moku. Quintette strikes a delicate balance between
the simplicity of Go Moku, and the deep strategies of GO.
At first glance Quintette looks like a variation of tic-tac-
toe, and it's rules are deceptively simple to learn, but the
player soon finds more sophisticated levels of strategy,
and the game becomes increasingly absorbing. The
Quintette application also plays Go Moku, and can be
used as a playing surface for other games that use the
same type of board as Quintette, such as GO.

THE OBJECT

There are two ways to win in Quintette:

1. By creating an unbroken row of five (or more) or
your stones in a row, horizontally, vertically, or
diagonally, or

2. By capturing five (or more) pairs of your opponent’s
stones.

THE BOARD

The board is a 19 x 19 grid of intersections. Stones are
placed on the intersections (called points), and on the
edge of the board; not in the spaces between them:

THE STONES

The first player (normally black) places the first stone on
the center point. The players then take turns placing their
stones, one per turn, on any empty point. Stones are not
removed from the board, except when they are captured
(see below). The game continues, turn by turn, until one
player wins.

THE TOURNAMENT RULE

In Quintette, as well as Go-Moku, the first player has a
slight advantage over the player that moves second. To
remove this advantage, the Tournament Rule states that
the first player's second move must be three or
more points away from the center. A square may be
traced between the four innermost stars on the board.
The first player's second move must be on or outside this
square:

The Tournament Rule may be turned off. See below.

CAPTURING

You may capture a pair of your opponent's stones by
bracketing both of the pair's ends with your stones. Only
pairs (two adjacent stones, horizontally, vertically, or
diagonally) are vulnerable to capture. Captured pairs are
always removed; you may not choose to leave them on

the board. Captured pairs are indicated on the sides of the
board.



Example: Black places a stone on the indicated point,
bracketing White's pair. The pair is then captured and
removed from the board, as shown.
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Multiple captures: You may capture more than one
pair of opponent's stones with a single move.

Example: Black's move brackets both of White's pairs,
and thus captures them.

Moving into a captured position: You may play a
stone on any unoccupied point, even if that point has been
previously occupied, or forms a pair between two of your
opponent's stones.

Example: White's move below is legal and no pieces are
captured.
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PLAYING HINTS
The goal of the game is to get an unbroken row of five (a

Quintette)...

...or to capture five pairs of your opponent's stones (also
a Quintette):

One subgoal of winning can be to obtain an unbroken row
of four stones, unblocked on both ends. This
configuration is called a quartette:
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As you can see, no matter which end the opponent blocks,
you may play the other end to achieve a win. If your
opponent has the configuration below, a trio, you must
quickly block one end or the other to prevent your
opponent from making a quartette:
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Some situations are not as obviously dangerous as the
quartette and trio. In the situation below, Black must
block in one of the three circled points in order to prevent
White from making a quartette.



BASIC STRATEGY

To win Quintette, it 1s best to gain the initiative. The
player who has the initiative 1s able to control the flow of
the game more effectively, and influence it's final
outcome. To gain the initiative, you must make stronger
and more threatening moves than your opponents,
forcing them to counter your moves rather than moving
to advance their ultimate goals. Building intersecting
groups of threes and fours can also be helpful in gaining
the initiative. Move to give yourself the most options in
the future, and work towards building a "double threat”
that your opponent cannot block completely.

GO MOKU

The rules for Go Moku are identical to Quintette with
one exception: Go Moku does not allow or consider
captures, so there is only one way to win; by making five
in a row. Moves which would capture in Quintette do
nothing extrordinary in Go Moku, so don't make such
moves unless you have some other strategic reason for
doing so.

STARTING UP

If you are unfamtihar with how to start up a Macintosh
application, it is advisable to read the Macintosh owner's
manuals before trying to use Quintette. If you are
familiar with how the Macintosh works, simply boot the

disk, and/or double-click the Quintette icon from the
Finder.

PLAYING THE GAME

When Quintette starts up, you will see the board in the
center of the screen. It will be preset to play a game of
Quintette at the Intermediate 1 level. The computer will
take approximately 30 seconds to make it's move at this
level. If you have not played Quintette before you may
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want to select a lower level from the Difficulty menu.
Black moves first, and the human player is Black, so you
must make the first move of the game by using the mouse
to move the cursor to the center point of the board, and
clicking. You will notice that the cursor changes to the
shape of a black piece when it is over a legal move (in this
case, the center). If you try to make an illegal move, you
will hear a sound indicating that it is not allowable. If you
click again on an illegal move, Quintette will notify you
as to why that move 1s illegal.

Once you make a legal move, Quintette will begin to
contemplate it's response, and the cursor will flicker
through a variety of meditative symbols. Quintette will
then make it's move and it will be your turn again. When
the game is over no moves will be valid, so to start a new
game you must select New from the File menu. You may
tell Quintette to hurry up and finish it's thinking by
holding down the Command key (the cloverleaf key at the
bottom-left of the keyboard) and pressing the period
("."). Quintette will then finish it's thinking in about
five seconds, but it's move may be slightly inferior to the
move it would have made if it is allowed to finish.

THE MENUS

The Apple menu in the upper-left hand corner contains
the usual Macintosh desk accessories, and an About
Quintette... option that will show you the version,
author, copyright, and distribution notice.

The File menu contains the following commands:

Nei

Completely erase the current board position, and
start a new game using the settings from the Setup menu
(see below).



save
Save your current game.

Save As...

Save your current game under a new name. This
works like most other Macintosh applications.
Open...

Open a previously saved game. This works like
most other Macintosh applications.
Quit

This ends your session with Quintette and returns
you to the Finder.

The commands in the Edit menu are provided for use

with desk accessories only. They have no use in
Quintette.

Changing the settings in the Setup menu has no
immediate effect on the game currently in progress, but
will take effect when you start a new game by selecting
New from the File menu, or clicking the 0K button in the
Modify Board mode. The settings in the Setup menu
are:

Play Quintette

The new game will be played by Quintette rules.
Play Go Moku

The new game will be played according to Go
Moku rules.

Human Black vs. Computer White

You will play black against Quintette.
Human White vs. Computer Black

You will play white against Quintette.

Human vs. Human

You and another player will match wits.
Computer vs. Computer
Quintette will play itself.

Black Goes First

The black player (determined above) goes first.
IDhite Goes First

The white player (determined above) goes first.
Flip For It

The first player will be chosen randomly when the
game starts.

Use Tournament Rule
If checked, the Tournament Rule will be enforced.

The Difficulty menu allows you to select how long
Quintette gets to think about it's move. The times are

approximately:
Novice 1 5-10 seconds
Nobvice 2 10-20 seconds

20-30 seconds
30-40 seconds

1- 3 minutes

Intermediate 1
Intermediate 2
Intermediate 3

Advanced 1 5-10 minutes
Advanced 2 10-15 minutes
Overnight 6- 8 hours



The Features menu contains the following commands
and options:

Show/Hide Move List

This displays or removes the list of moves 1n the
current game. Each move is notated by it's distance from
the center point, which is designated 0:
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Moves which cause captures are notated with an
asterisk ("*"). You may use the scroll bar to scroll
through a move list that is too long to fit on the screen at
once.

Modify Board

Selecting this allows you to edit the current board
position. You will see two buttons, labeled 0K and Undo.
Clicking the Undo button restores the board position to
it's unmodified state. Clicking 0K saves your changes and
starts a new game using the settings in the Setup menu.
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EDITING THE BOARD

Below the 0K and Undo buttons is a stone that will
be black initially and you will notice that clicking on it
changes it from Black to White and back again. You can
also hold down the Shift key to temporarily change the
color of the stone. When you click on an empty point you
will place stones of the same color as the indicator stone.
You will continue to place stones of that color as long as
you hold down the mouse button. Removing stones works
the same way, except you click on an occupied point to
begin removing stones.

SETTING CAPTURES

If the Setup menu indicates that the new game will
be played by Quintette rules, two diamond shaped
controls will appear at the lower-left and upper-right of
the board. Clicking and dragging up and down in these
controls will change the number of captures the players

have. White stones appear for Black's captures, and
Black stones for White's.

PLAYING OTHER GAMES

Several other ancient games, such as GO, use a
board like that used in Quintette. By entering the
Modify Board mode, no restrictions are placed on the
movement of stones, so GO and other games can be
played between two humans. You can save your game by
clicking the 0K button and saving as usual. Of course,
Quintette does not know how to play GO, etc. so no
Move List is generated.
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Turn Sound Off/0n

If you would rather not hear the sound effects
generated by Quintette, sclect this option. To restore
the sound, select it again.

Take Back Move and Done Taking Back

Moves in the Move List can be taken back. When
you select Take Back Move one move will be removed
from the board and any captures that move caused will be

replaced. The game in progress will be suspended until
you select Done Taking Back.

EXAMPLE: You realize that the move
Quintette just made is a killer, and you wish to replay
the move before Quintette's. You select Take Back
Move and Quintette's move dissappears. It 1s now
Quintette's move again but it won't move unless you
select Done Taking Back. You wish to take back your
move now, so you select Take Back Mouve once again
and your move (the one you didn't like) dissappears. You
now select Done Taking Back and the game resumes. It

1s now your turn and you are free to select a different
move.

We hope you enjoy Quintette and would be interested in hearing your comments
and suggestions. Please take a few moments to become a Registered Owner by
filling out the card provided and sending it to us. We will notify you of
additions and updates to Quintette, which as a Registered Owner you will be
entitled to at a nominal update charge.
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